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1 About ARKSP (Admin Report Kit for SharePoint)  

 

1.1 About ARKSP 

Admin Report Kit for SharePoint (ARKSP) is a powerful configuration and usage 

reporting tool for Microsoft Office SharePoint Portal Server 2003 and Windows 

SharePoint Services.  ARKSP presents information across virtual servers, portal sites, 

site collection and lists in SharePoint in a simple report format.   

ARKSP collects configuration information about Windows SharePoint Services, Portal 

Sites, Site Collection, Web and Areas.  List Configuration and List Details etc. and reports 

them in a format for use by SharePoint Administrators. ARKSP also presents the usage 

information about site collection and list items. ARKSP supports current version of 

Microsoft Office SharePoint Portal Server 2003 and Windows SharePoint Services only. 

 

1.2 Who can use ARKSP? 

Organizations running Microsoft Office SharePoint Portal Server 2003 and Windows 

SharePoint Services can greatly benefit from ARKSP. It is a powerful reporting tool 

collects configuration information about Windows SharePoint Services, Portal Sites, Site 

Collection, Web and Areas, List Configuration and List Details etc. and reports them in a 

format for use by SharePoint Administrators. 
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1.3 System Requirements  

Processor Intel Pentium Processor 

Disk Space & Memory 512 MB RAM and minimum of 15 MB of free disk space 

Operating System Microsoft Office SharePoint Portal Server 2003 (or) 

Windows SharePoint Services with latest Service Pack, 

Microsoft Data Access Components (MDAC) v2.8 only. 

Software Microsoft Data Access Components (MDAC) v2.8 only 
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1.4 How to Activate the Software? 

Once you purchase the software online or through any one of our resellers, you will 

receive a sale notification through e-mail from our sales department. We will send you 

an e-mail with the necessary instructions to activate the software. 

In case you do not receive an e-mail from our sales team after you purchase the 

software, please send the following information to our sales department at 

sales@vyapin.com with the sales order number: 

 Company Name: End-user Company Name 

 Location: City & Country for the Company Name given above 

Please allow 12 to 24 hours from the time of purchase for our sales department to 

process your orders. 

 

Image 1 - Activate screen 

Perform the following steps to activate the software: 

1) Download evaluation/trial copy of software from the respective product page 

available in our website at http://www.vyapin.com/ 

2) Install the software on the desired computer. 

3) You will receive a license key through e-mail as soon as the purchase process is 

complete. 

4) Click 'Activate' in Help -> About -> Activate menu to see the Activate dialog (as 

shown in Image 1). 
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5) Copy the license key sent to you through email, and pastes it in the 'License Key' 

textbox. For help on how to copy the license key, click 'Click here to see how to 

copy and paste the license key' link in the Activate dialog (as shown in Image 2). 

 

Image 2 - How to copy license key screen 
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2 Using ARKSP- Quick Reports 

2.1 Single Sign-On  

Single Sign-On Reports 

Single Sign-on Reports provides Single Sign-on configuration details in SharePoint Portal 

Server. Single Sign-On report is classified into two reports: 

Single Sign-on Application Definitions: Enterprise Application Definition settings 

configured in Single Sign-on administration in SharePoint Portal Server. This report 

shows details such as Application Name. Display Name, Account Type, Contact E-Mail, 

Mask fields and it‟s values. This report is useful when large number of enterprise 

application settings is configured. You can view all enterprise application settings in 

single screen. 

Single Sign-on Server Settings: Provides useful information such as Server name, 

Single sign-on database name, SQL server name etc. 

Click File ->Quick Reports to invoke ARKSP Quick Reports Wizard. 
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Select any desired report, Click Finish button. 

Click {Single Sign-on Application Definition} to display information about {Enterprise 

Application Definition Settings}. This report displays the following information: 

{Application name, Display Name, Account Type, Contact E-mail, Field1, Mask 

Field1, Field2, Mask Field2, Field3, Mask Field3, Field4, Mask Field4, Field5, 

Mask Field5}. 
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Click {Single Sign-on Server Settings} to display information about {Server Settings for 

Single Sign-On}. This report displays the following information: {Server, Database 

name, Ticked time-out in minutes, Delete Audit Log Records Older Than (in 

days), SQL Server, Secret Server, Single Sign-On-Account Name, Enterprise 

Application Definition - Account Name}. 

 

 

2.2  Portal Site 

Portal Site Reports 

Portal Sites Reports presents the Portal Sites configured across all portal servers in 

SharePoint Portal Server. Portal Sites report provides information about: 

 Portal Audience: Audience information such as audience name, audience rules, 

last compilation. Etc., 

 Portal Search Scopes: List all search scopes and it‟s properties such as search 

scope name, topics and areas applicable, content source groups. 

 Portal Keywords: List keywords, description, it‟s best bets in the portal and the 

user who created the keyword. 

 Portal Users: Reports about distinct users in the portal site. 

 Portal User Profile: Reports about the user profile information stored in the 

profile database. 

 Personal Sites: Reports about personal sites configured in the portal server and 

it‟s properties such as personal site url, quota etc., 

Click File ->Quick Reports to invoke ARKSP Quick Reports Wizard. 
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Select any desired report, Click Finish button. 

Click {Portal Audience} to view details about Audience information across all Portal 

Sites. This report displays the following information: {Portal Name, Portal URL, 

Audience Name, Audience Site, Audience Description, Membership, Last 

Compilation, Last Compilation Status, and Last Rule Update}. 

 

Click {Portal Search Scopes} to view the available Search Scopes defined across all 

Portal Sites. This report displays the following information: {Portal Name, Portal URL, 

Scope name, Topics and Areas, Content Source Groups, Default}. 
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Click {Portal Keywords} to view the Key Words defined for all Portal Sites. This report 

displays the following information: {Portal Name, Portal URL, Keyword, Keyword 

Description, Synonyms, Best Bet Title, Best Bet Description, Web Address, 

Created By, and Status} 

 

Click {Portal Users} to view the distinct users added across all portal sites. This report 

displays the following information: {Portal Name, Portal URL, Login Name, and 

Type}. 
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Click {Portal User profile} to view the personal details of the users in the profile 

database across all portal sites. This report displays the following information: {Portal 

Name, Portal URL, AccountName, FirstName, LastName, PreferredName, 

WorkE-mail, Work Phone, Department, Title, Manager, AboutMe ...}. Additionally, 

User Profile report will also display the information of all the fields that are created 

manually in the profile database. 

 

Click {Personal Sites} to view personal sites created across all portal sites. This report 

displays the following information: {Portal Name, Portal URL, Personal Site Name, 

Personal Site URL, Number of Users, Owner, and Quota (in MB)}. 
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2.3 Virtual Server 

Virtual Server Reports 

Virtual server report deal with providing information about the virtual servers configured 

in the SharePoint Portal server. This report provides the following details: 

 virtual server configuration 

 user rights of the virtual server 

 site collection and configuration 

 data retrieval service settings of the virtual server  

 e-Mail settings of the virtual server  

 managed path configuration information 

 content database information 

 site quota information 

 pages visited in all the sites under the virtual server  

Click File -> Quick Reports to invoke ARKSP Quick Reports Wizard.      

 

Perform the following steps to run a quick report under the Virtual Server category:  
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Step 1: Select a report and click Next button (when a report scope is applicable, 

otherwise click the Finish button). This will display a window as shown below: 

 

Step 2: Choose a report scope:  

'All virtual servers' - Collects the report data for all virtual servers configured in 

SharePoint 

'Connected virtual server only' - Collects report data for the specified virtual server only. 

Type a valid 'Virtual Server URL or click '...' button to choose a virtual server. 

Step 3: Click Finish button. This will collect the data for all virtual servers in the 

SharePoint server. 

NOTE: For Site Collection Summary, Disk Quota Limits and Usage and Page 

Visits reports, data can be viewed either for All virtual servers or Connected virtual 

server only by choosing the appropriate scope. 

A brief description of each report along with the report fields and a sample screen 

available under Virtual Server category is given below: 

Click {Virtual Server Summary} to view details about Summary information across all 

Virtual Servers. Displays the following information: {Virtual Server, State, Host 

Name, Port Number, Version, and Content Database}. 
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Click {Site Collection Summary} to view details about Summary information about all 

top level sites across all Virtual Servers. Displays the following information: {Virtual 

Server, State, Site URL, Primary Owner Name, Primary Owner Display Name, 

Primary Owner E-mail, Secondary Owner Name, Secondary Owner Display 

Name, Secondary Owner E-mail, Time Zone, Sub Webs, Site Groups, Alerts, 

Inherits Security}. 

 

Click {Virtual Server General Settings} to view general settings defined for all Virtual 

Servers. Displays the following information: {Virtual Server, State, Site URL, Default 

Time Zone, Default Quota Template, Maximum Upload Size (MB), Alerts 

Enabled, Maximum Alerts, Security validation, Security validation timeout, Job-

usage-analysis, Event Handlers Enabled}. 
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Click {Virtual Server E-Mail Settings} to view E-Mail Settings configuration details for all 

Virtual Servers. Displays the following information: {Virtual Server, State, Site URL, 

E-Mail Inserts Enabled, Public Folder URL, Check for new e-mail, Outbound 

SMTP server, From Address, Reply to Address}. 

 

Click {Managed Paths} to view Included/Excluded Path details for all Virtual Servers. 

Displays the following information: {Virtual Server, State, Site URL, Included Path, 

and Excluded Path}. 



CHAPTER 2 – Using ARKSP   

15 

 

Click {Content Database} to view the Content Database details for all Virtual Servers. 

Displays the following information: {Virtual Server, State, Site URL, Database 

Server, Database Name, Database Status, Current Number of Sites, Site Level 

Warning, and Maximum Number of Sites}. 

 

Click {Data Retrieval Settings} to view the Data Retrieval Service Settings Configuration 

details about all Virtual Servers. Displays the following information: {Virtual Server, 

State, Site URL, Data Retrieval Service, Services Enabled, Limit Response Size 

(KB), Update Support Enabled, Data Source Time-out (Secs)}. 
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Click {Disk Quota Limits and Usage} to view the Site Collection Quota information for all 

Virtual Servers. Displays the following information: {Virtual Server, State, Site URL, 

Disk Used (in MB), Disk Quota (in MB), and Disk Warning (in MB)}. 

 

Click {Page Visits} to view the pages visited in all the sites under a virtual server. 

Displays the following information: {Virtual Server, State, Site URL, Page URL, Page 

Hits, User, Client IP Address, and Visited Date}. 
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Click {Virtual Server User Rights} to view the User rights defined for all Virtual Servers. 

Displays the following information: {Virtual server, State, Site URL, User rights}. 
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2.4 Site / Area Reports (SPS only)   

Site / Area Reports provide useful configuration and usage information about the 

connected portal site / portal area. ARKSP provides not only currently connected 

site/area information, but also its sub-sites/sub-areas. This report section provides the 

following details: 

 General settings, configuration settings of the site/area  

 Alerts configuration  

 Site user details, provide users details of the site/area and user rights   

 Files accessed and users who have visited the site  

 Web Parts and Web Pages present in the given site/area  

 Site Groups and Cross-site Groups in the given site/area 

NOTE: ARKSP will not display Cross-site Groups and Web Pages tabs when you connect 

to a Portal Area URL.  

Click File ->Quick Reports to invoke ARKSP Quick Reports Wizard. 

 

Select any desired report and Click Next button to continue. This will display a window 

as shown below: 
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Select any of the following scope for the report to be viewed:  

a) All sites in virtual server - If URL entered is a valid virtual server URL, ARKSP 

retrieves report information for all the sites, including sub-sites and  top level 

sites, in the virtual server  

b) Connected site and its sub-sites - Retrieves report information for the 

connected site and its sub-sites  

c) Connected site only - Retrieves report information for the connected site only. 

By default, All sites in virtual server option will be selected. 

To connect to a particular portal site / portal area:   

1) Type full URL of the site/area in the format http://servername:port 

number/sitename (or)  

2) Click '...' button to show the Select a SharePoint Site/Area dialog as shown 

below: 
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3) Select the required site/area and Click OK button.  

4) Click Finish button in the wizard. 

A brief description of each report along with the report fields and a sample screen 

available under Site / Area Reports category is given below: 

Click {Site Summary} to view Summary details for the selected scope. It displays the 

following information: {Web Title, Web URL, Author, Display Name, E-mail, 

Created On, Last Modified, Web Size in (MB), Sub Webs, Number of Lists, 

Number of Alerts, Number of Users, Number of Site Groups}. 
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Click {Site Settings} to view the configuration details for the selected scope. It 

displays the following information: {Web Title, Web URL, Time Zone, Title, 

Description, Inherits Security, Theme, and Template}. 

 

Click {Site Hits Summary} to view the site usage summary information for the selected 

scope. It displays the following information: {Web Title, Web URL, Total Hits, Recent 

Month Hits, Recent Day, and Recent Day Hits}. 
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Click {Page Hits} to view details about website files accessed for the selected scope. It 

displays the following information: {Web Title, Web URL, File URL, Total Hits, 

Recent Month Hits, Recent Day, and Recent Day Hits}. 

 

Click {Site Visitors} to view details about users who has accessed the site for the 

selected scope. It displays the following information: {Web URL, Web Title, User, 

Total Hits, Recent Month Hits, Recent Day, and Recent Day Hits}. 
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Click {Site Groups} to view site groups and their Users and their permission(s) for the 

selected scope. It displays the following information: {Web URL, Path, Web Title, Site 

Group, Site Group Description, Rights, and Members}. 

NOTE: Path field is applicable only for Area URL(s) and will be blank for Site URL(s). 

 

Click {Site Users} to view the Users and their permission(s) for the selected scope. It 

displays the following information: {Web URL, Web Title, Path, User Name, Display 

Name, E-Mail, and Member Of, Permissions}. 

NOTE: Path, Permissions fields are applicable only for Area URL(s) and will be blank 

for Site URL(s). 
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Click {Cross-site Groups} to view the cross-site groups and their members for the 

selected scope. It displays the following information: {Web Title, Web URL, Cross-site 

Group, Description, Owner, Parent Web, Members}. 

 

Click {Alerts} to view the Alerts configured for the selected scope. 

 If user connect to the Area following information are displayed: {Web Title, 

Web URL, Alert Title, Alert State, User, Delivery Text, Conditional Text, 

and E-mail}. 

 If user connect to the Non Area following information are displayed: {Web Title, 

Web URL, Alert Title, User, Frequency, Type, and Send Alerts About}. 
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Click {Site Templates} to view site templates information for the selected scope. It 

displays the following information: {Web URL, Web Title, Site Template Title, Site 

Template Name, Description, and Is Custom Template}. 

 

Click {Web Pages} to view the web pages and their web parts information for the 

selected scope. It displays the following information: {Web URL, Web Title, Web 

Pages Title, Web Page URL, Author, Created On, Last Modified, Page Size in 

(KB), Total Size in (KB), and Web Part Title}. 
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Click {Web Parts} to view the web parts information for the selected scope. It displays 

the following information: {Web Title, Web URL, Web Part Title, Web Part Name, 

Parent Folder, Author, Created On, Last Modified, and Size in (KB)}. 
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2.5 Site {WSS Only}   

Site Reports (WSS) 

Site Report provides useful configuration and usage information about the connected 

site. ARKSP provides not only currently connected site information, but also its sub-sites. 

This report provides the following details: 

 General settings, configuration settings of the site  

 Alerts configuration  

 Site users details, provide users details of the site and user rights   

 Filtered data such as unused lists, top lists, top versions, top folders and files  

 Files accessed, users visited the site  

 Web Parts, Web Pages 

Click File ->Quick Reports to invoke ARKSP Quick Reports Wizard. 

 

Select any desired report and Click Next button to continue. This will display a window 

as shown below: 
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Select any of the following scope for the report to be viewed:  

a) All sites in virtual server - If URL entered is a valid virtual server URL, ARKSP 

retrieves report information for all the sites, including sub-sites and  top level 

sites, in the virtual server  

b) Connected site and its sub-sites - Retrieves report information for the 

connected site and its sub-sites  

c) Connected site only - Retrieves report information for the connected site only. 

By default, All sites in virtual server option will be selected. 

To connect to a particular site:   

1) Type full URL of the site in the format http://servername:port number/sitename.   

2) You can also Click  button to show the Select a Windows SharePoint 

Services Site dialog as shown below: 
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3) Select the required site and Click OK button. 

4) Click Finish button in the wizard. 

A brief description of each report along with the report fields and a sample screen 

available under Site Reports category is given below: 

Click {Site Summary} to view Summary details for the selected scope. It displays the 

following information: {Web Title, Web URL, Web URL, Author, Display Name, E-

mail, Created On, Last Modified, Web Size in (MB), Sub Webs, Number of Lists, 

Number of Alerts, Number of Users, Number of Site Groups}. 
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Click {Site Settings} to view the configuration details for the selected scope. It displays 

the following information: {Web Title, Web URL, Time Zone, Title, Description, 

Inherits Security, Theme, and Template}. 

 

Click {Site Hits Summary} to view the site usage summary information based on user 

visits for the selected scope. It displays the following information: {Web Title, Web 

URL, Total Hits, Recent Month Hits, Recent Day, and Recent Day Hits}. 
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Click {Page Hits} to view details about website files accessed for the selected scope. It 

displays the following information: {Web Title, Web URL, File URL, Total Hits, 

Recent Month Hits, Recent Day, and Recent Day Hits}. 

 

Click {Site Visitors} to view details about users who accessed the site for the selected 

scope. It displays the following information: {Web URL, Web Title, User, Total Hits, 

Recent Month Hits, Recent Day, and Recent Day Hits}. 
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Click {Site Groups} to view site groups and their Users and their permission(s) for the 

selected scope. It displays the following information: {Web URL, Web Title, Site 

Group, Site Group Description, Rights, and Members}. 

 

Click {Site Users} to view the Users and their permission(s) for the selected scope. It 

displays the following information: {Web URL, Web Title, User Name, Display 

Name, E-Mail, and Member Of}. 

 

Click {Cross-site Groups} to view the cross-site groups and their members for the 

selected scope. It displays the following information: {Web Title, Web URL, Cross-site 

Group, Description, Owner, Parent Web, Members}. 
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Click {Alerts} to view the Alerts Configured for the selected scope. It displays the 

following information: {Web Title, Web URL, Alert Title, User, Frequency, Type, 

and Send Alerts About}.  

 

Click {Site Templates} to view the site templates available in the virtual server. Displays 

the following information: {Web URL, Web Title, Site Template Title, Site Template 

Name, Description, Is Custom Template} 
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Click {Web Pages} to view the web pages and their web parts information for the 

selected scope. It displays the following information: {Web URL, Web Title, Web Page 

Title, Web Page URL, Author, Created On, Last Modified, Page Size in (KB), Total 

Size in (KB), and Web Part Title}. 

 

Click {Web Parts} to view the web parts information for the selected scope. It displays 

the following information: {Web Title, Web URL, Web Part Title, Web Part Name, 

Parent Folder, Author, Created On, Last Modified, and Size in (KB)}. 
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2.6 List 

List Reports 

List report shows detailed information about all the list types such as document library, 

picture library, contacts etc., and this report provides configuration information, users, 

columns, and views information based on the scope and URL specified. 

For the Document Library, Picture Library, Form Library, ARKSP reports size of the list, 

number of folders and files, top folders and files in the list, file types present in the list 

such as DOC, XLS, HTML, PPT etc. 

NOTE: ARKSP does not display List Users tab when you select a list in a Portal Area. 

Click File ->Quick Reports to invoke ARKSP Quick Reports Wizard. 
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Select any desired report and click Next to continue. This will display a window as 

shown below: 

 

Select any of the following scope for the report to be viewed: 

 All lists in the connected site and its sub-sites - If URL entered is a valid site 

URL, ARKSP retrieves report information for all lists in the connected site and its 

sub-sites.  

 All lists in the connected site - Retrieves report information for all the lists in 

the connected site.  
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 Connected list only - Retrieves report information for the connected list only. 

By default, Connected list only option will be selected. 

To connect to a particular site or list:   

1) Type full URL of the site/area in the format http://servername:port 

number/sitename or http://servername:port number/sitename/listname for the 

scope option selected.  (or)  

2) You can also Click  button to show the Select a SharePoint List or Select a 

SharePoint Site dialog as shown below: 

 

If All lists in the connected site and its sub-sites or All lists in the connected site 

option is selected, you may view the report data only for the lists that belongs to a 

particular list template (e.g. Document Library, Picture Library). 

Click Get List Templates button to enumerate all the lists that are available in the 

selected URL. By default, 'All' will be selected, which collects data for all the lists in the 

site. 

Click Finish button. 
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A brief description of each report along with the report fields and a sample screen 

available under List Reports category is given below: 

Click {List Summary} to view Summary details for the list(s). 

This report displays the following information: {Web URL, Web Title, Base Template, List 

Name, Number of Columns, Last Modified Date, Last Deleted Date, Number of Users, 

Number of Folders, Number of Items, and Size of the List (in MB)} 

 

Click {List General Settings} to view general details for the list(s). 

This report displays the following information: {Web URL, Web Title, Base Template, List 

Name, Description, Web Address, Document Template, Permission Inheritance, Generate 

Versions, Attachments Enabled, On Quick Launch Bar, Content Approval Required, Show 

server names in survey results, Allow multiple responses, Send e-Mail to person 

assigned to issue, Read Access, Edit Access} 
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Click {Columns} to view the available columns for the list(s). This report displays the 

following information: {Web URL, Web Title, Base Template, List Name, Column 

Name, Type, Description, Required, Optional Values}. 

 

Click {Views} to view the available Views for the currently connected list. This report 

displays the following information: {Web URL, Web Title, Base Template, List 

Name, View Name, View Type, and Is Default}. 
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Click {List Users} to list the users granted permission in the currently connected list. 

This report displays the following information: {Web URL, Web Title, Base Template, 

List Name, Permission(s), Type, E-Mail, Display Name, Rights}. 

 

Click {List Templates} to view information about the list templates available in the 

virtual server. This report displays the following information: {Web URL, Web Title, 

List Template Title, List Template Name, List Template Type, Description, Is 

Custom Template}      
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Click {Top List Items} to list top 10 (default value is 10) lists that contain large number 

of folders/files in the site(s). User can enter any number to view the top items in the list. 

This report displays the following information: {Web URL, Web Title, Base Template, 

List Name, and Number of Items}.    

 

Click {Top List Size} to list top 10 (default value is 10) lists in the site(s) based on the 

size. User can enter any number to view the top items in the list. This report displays the 

following information: {Web URL, Web Title, Base Template, List Name, and Size 

(in MB)}. 
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Click {Date Last Modified} to view the last modified date for each list in the specified 

scope. This report displays the following information: {Web URL, Web Title, Base 

Template, List Name, and Last Modified Date}. 

 

Click {Newly Added Items} to view the list items that are added in a list in the last 'N' 

days. This report displays the following information: {Item URL, Size (in MB), 

Created By, and Created Date} 
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Click {Last Modified Items} to view the list items that are modified in the last 'N' days. 

This report displays the following information: {Item URL, Size (in MB), Modified By, 

and Modified Date} 

 

Click {Last Deleted Items} to view the list items that are deleted in the last 'N' days. 

This report displays the following information: {Deleted Date, Item URL, and Deleted 

By}. This report is applicable to Document Library, Picture Library and Form 

Library only. 
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Click {List Hits Summary} to view the lists that are accessed in last 'N' days and number 

of times they have been accessed. This report displays the following information: {Item 

URL, Item Hits, and Last Accessed Date}. This report is applicable to Document 

Library, Picture Library and Form Library only. 

 

Click {List Visits} to view the list items that are accessed in the last 'N' days. This report 

displays the following information: {Item URL, Item Hits, Accessed By, Accessed 

Date, and Accessed Time}. This report is applicable to Document Library, Picture 

Library and Form Library only. 

 

Click {File Types} to list the type of files in the currently connected list. This report 

displays the following information: {Web URL, Web Title, Base Template, List 

Name, File Type, and Count}. This report is applicable to Document Library, Picture 

Library and Form Library only. 
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Click {All Folder Items} to display items count of each folder and sub-folder in a list. This 

report displays the following information: {Web URL, Web Title, Base Template, List 

Name, Folder, and Number of Items}. This report is applicable to Document Library, 

Picture Library and Form Library only. 

 

Click {Version History} to list top 10 (default value is 10) files that have the most 

number of versions. User can enter any number to view the top items in the list. This 

report displays the following information: {Document URL, Number of Versions, 

Latest Version, Version ID, Created By, Created Date, Modified By, Modified 

Date, and Size (in MB)}. This report is applicable to Document Library, Picture Library 

and Form Library only. 
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Click {Stale Lists} to displays the lists that are not used for certain number of days. This 

report displays the following information: {Web URL, Web Title, Base Template, List 

Name, Created Date, and Last Modified Date, Not used (in days)}.   

 

Click {Unused Lists} to display the lists that are not used from the day it was created. 

This report displays the following information:  {Web URL, Web Title, Base Template, 

List Name, and Last Modified Date} 
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3 Power Reports 

3.1 About Power Reports 

ARKSP provides an offline report generation tool called Power Reports. Power Reports 

tool allows the user to select multiple reports to be run for several SharePoint entities 

(namely, sites, areas and lists), with powerful data filter options and finally run the 

reports at scheduled intervals. The Power Reports tool has the ability to export, publish, 

and print the reports to different network locations. 

ARKSP Power Reports Wizard will help you create and store the settings for a task in the 

Power Reports Task Manager. The scheduled task will take the schedule settings 

(Schedule Type, Run As parameter) provided using the ARKSP Power Reports Wizard. 

The task will not run unless a valid password is specified for the Run As parameter. 

Please note the following information prior to using the Power Reports Wizard: 

a) The report that is scheduled will be created as a task in Windows Task Scheduler. 

The Schedule Manager allows you to export / publish the reports in different file 

formats (MDB, CSV, HTML and XML) to the desired path/location and/or print the 

scheduled reports.  

b) The export option follows the naming convention: <<export path>>\<<task 

name>>\<<report generated date and time>>\<<report name>>  

c) For each file format (MDB/HTML/CSV/XML), a separate file will be created based 

on report category. For example, in MDB file format, for each report category an 

MDB file will be created. 
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3.2 Task Manager 

Power Reports Task Manager 

The Power Reports Task Manager allows you to perform the following operations: 

 Create a new task  

 Edit an existing task  

 Copy an existing task  

 Delete a task  

 View properties for the tasks created  

 View history for the tasks created  

 Run the task immediately  

 Cleanup task history 
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3.3 Create Task 

New Task 

Click or  or press Ctrl + W   

A sample Power Reports Task Manager window is shown below: 

 

Click New Task button. The Power Reports Wizard will be displayed as shown below: 
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Click Next to Continue. 

Step 2: Select Report(s) 

 

1) Select the report(s) using the checkboxes to the left of the reports. You may 

select any number of reports to run in a single task.  

2) Click Next to proceed to the next step. You may Click Back button anytime to 

come back to a previous step. 
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Step 3 : Select Virtual Server 

NOTE: This step is applicable only if a virtual server report is selected in Step 2. 

 

Click Add / Edit button to specify URLs for the virtual server reports selected in step 2.  

Click Delete URL button to delete a selected URL. Click Delete Report button to delete 

the selected report and its URLs. 

Clicking Add/Edit button will display a window as shown below: 

 



CHAPTER-3 – Power Reports  

53 

By default, All virtual server option will be selected. The scope option can be changed 

to Connected virtual server only for Site Collection Summary, Disk Quota Limits 

and Usage, Page Visits reports only. 

To add the virtual server URL, 

1) Enter a valid virtual server URL and click Add (or)  

2) Click 'Browse...' button to choose URL(s). This will display a window as shown 

below: 

 

Click OK button in the connect window to add the report to the grid in the Specify Scope 

and URL dialog. 

To apply the same set of URLs to multiple reports, click 'Apply to...' button in the Specify 

Scope and URL window. 

Finally, click OK button in the Specify Scope and URL window to apply the scope and 

URLs for the virtual server reports. 
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Step 4 : Select Site / Area  

NOTE: This step is applicable only if a site level report is selected in Step 2. 

 

Click Add/Edit button to specify the scope and select the site URL(s) for which you wish 

to run the site reports selected in Step 2.  Click Delete URL button to delete a selected 

URL. Click Delete Report button to delete the selected report and its URLs.  

Clicking Add/Edit button will display a window as shown below: 
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Select a scope option. The default scope of the report will be for the Connected site 

only. The scope options are: 

a) All sites in virtual server - Retrieves report information for all the sites, 

including sub-sites and  top level sites, in the virtual server 

b) Connected site and its sub-sites - Retrieves report information for the 

connected site and its sub-sites  

c) Connected site only - Retrieves report information for the connected site only. 

NOTE: 'All sites in virtual server' option is applicable only for Root URL. Options 

(a) and (b) may take time depending on the size of you web. 

To add the Site URL, 

1) Enter a valid site URL and click Add (or)  

2) Click 'Browse...' button to choose URL(s). This will display a window as shown 

below: 

 

Click OK button to add the selected URLs to the grid in Specify Scope and URL window.  

To change the scope option for any of the URLs added in the grid, click 'Change Scope' 

button. 
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To apply the same set of URLs for multiple reports, click 'Apply to...' button.  

Finally, Click OK button in the Specify Scope and URL window to apply the specified 

scope and URL for the reports. 

Step 5: List Selection 

NOTE: This step is applicable only if a list level report is selected in Step 1. 

 

Click Add/Edit button to specify the scope and select the site URL(s) for which you wish 

to run the site reports selected in Step 2. Click Delete URL button to delete a selected 

URL. Click Delete Report button to delete the selected report and its URLs. 

Clicking Add/Edit button will display a window as shown below: 
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Select a scope option. The default scope of the report will be for the Connected list 

only. The scope options are: 

a) All lists in the connected site and its sub-sites - Retrieves the report 

information for all the lists in the connected site and its sub-sites  

b) All lists in the connected site - Retrieves the  report information for the all the 

lists in the connected site 

c) Connected list only - Retrieves the report information for the connected list 

only. 

NOTE: All lists in the connected site and its sub-sites option may take 

time depending on the size of your web. 

To add the list URL, 

1) Enter a valid URL based on the scope selected and click Add (or)  

2) Click 'Browse...' button to choose URL(s). This will display a window as shown 

below (in this case, window displayed for Connected list only option): 
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Click OK button to add the selected URLs to the grid in Specify Scope and URL window. 

To change the scope option for any of the URLs added in the grid, click 'Change Scope' 

button. 

To collect report data only for the lists that belong to a specific list type, Select a URL in 

the grid and click 'Change List Template' button (not applicable for Connected list 

only option). 

To apply the same set of URLs for multiple reports, click 'Apply to...' button. 

Finally, Click OK button in the Specify Scope and URL window to apply the specified 

scope and URL for the reports. 

Step 6: Specify Report Criteria 

This step allows you to apply specific conditions for filtering report data. 
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1) To set a criteria for a report, select a report and   

2) The Report Criteria window will be displayed as shown below: 

 

3) Specify the criteria to filter the report data. 

a) Choose a field name from the dropdown, select an operator and specify a 

value in the value dropdown. You may enter a new value in the Value. For 

certain fields like “Inherits Security”, “Is Custom Template”, you may choose 

an existing value from the dropdown. 
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b) NOTE : 

Operators include a special operator called “like” and "not like". "like" 

determines whether or not a given character string matches a specified 

pattern. The operator “not like” performs the inverse function of the “like” 

operator. A pattern can include regular characters as well as some wildcard 

characters as given in the table below: 

Wildcard 

character 

Description Example 

[a]* Character starting with [a] Web Title LIKE '[a]*' finds Web Title 

names beginning with a, for example 

ARKSPSite, Adminsite, and so on. 

[a-f]* Any single character within the 

specified range ([a-f]) or set 

([abcdef]). 

Web Title LIKE '[a-f]*' finds Web Title 

names beginning with any single 

character between a and f, for 

example ARKSPSite,Custom Site, 

FirstSite, and so on. 

[a?]* Character starting with [a] and 

maximum of two characters 

including [a] 

Web Title LIKE '[a?]' finds all the Web 

Titles that has only two characters, 

starting with a, for example AT, AL, 

and so on. 

[a?d]* Maximum of three characters, 

the first character being a, the 

last character being d and 

middle character may be any 

single character 

Web Title LIKE '[a?d]' finds all the 

Web Titles that has only three 

characters, starting with a, ending 

with d and the middle character may 

be any single character, for example 

AND, ASD, etc. 

c) Click Add to Filter.  

d) The Add to Filter will change to AND to Filter. The OR to Filter button will 

be enabled. The selected condition will be set as a filter and will be displayed 

as shown below: 
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e) Use “AND to Filter” and “OR to Filter” , parenthesis (, ) etc., to build an 

enhanced filter condition as shown in the example below:  

([Web Title] = „ARKSP‟ And [Web URL] = „http://TestURL‟) OR ([Web Title] = 

„test‟ And [Web URL] = „http://TestingARKSP‟) 

f) To apply the same criteria for various URLs with the same report type and 

report, Click Apply To. 

g) Select the URL‟s to which you want to apply the criteria 

h) Click OK in Reports Criteria window to go back to the wizard.    

4) The applied criteria will be added to the report as shown below: 
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5) Click Next to Proceed to the next Step. 

Step 7: Specify Delivery Options 

 

To set the delivery options - export, publish and print settings for a report, select a 

report and Click Edit or Double Click the report 

1) Export Option: Change the Export path and export file format as necessary. 

 

2) Publish Option: Select Publish check box and specify a valid SharePoint 

library/folder URL.  

Choose a format and a file existence check option as required. 
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3) Print Setting: Select Print check box and choose a printer from the available list. 

 

4) File Settings: Each report will be exported into a new file. To export all the 

selected URLs for a report into a single file, select 'Create a single file' option. To 

export each URL for a report into a separate file, select 'Create separate file for 

each URL' option. Please note that 'File option' is applicable for Site/Area and List 

report categories only. 

If Single file option is selected, files with 'Report Name - Report Category' name 

format will be created and exported/published. 

If Separate file option is selected, you can choose the file name format from the 

available list. 
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To apply the same settings for multiple report selection, Click Apply To. 

Click OK. 

Step 8: Specify Schedule Settings 

 

1) Enter a unique name for the task 

2) Change the Run as parameter, if necessary and set the password for the specified 

user. 

3) Change the task schedule settings as required. 

4) Click Next to proceed to the next and final step. 
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Step 9: Summary 

 

This step displays the summary information of the task. 

Click Finish to save the task details. 

The task will be added to Windows Schedule Tasks and will be displayed in the Power 

Reports Task Manager Window as shown in the sample screen below: 
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3.4 Edit Task 

1) Select a task from the Power Reports Task Manager Window and Click Edit 

Task.   

2) Perform the steps 1 through 9 as in New Task. While proceeding you may 

change the settings, add a new report, delete a report, edit a report, change the 

export path etc., 

3) The new settings will be used when the task runs the next time. 

3.5 Copy Task 

You can copy an existing task in the Power Reports Task Manager to create a new task 

with the same properties. You may then edit the properties of the newly created task. To 

Copy a task from the existing task list: 

1) Select a task to be copied 

2) Click Copy Task 

3) The Copy Task window will be displayed as shown below: 

 

4) Enter a new task name, and specify the Run As account and password for the 

user context. 

5) Click OK 

The newly created task will be added to the Power Reports Task Manager. 

3.6 Delete Task 

To delete a task from the Power Reports Task Manager Window, select the task and Click 

Delete Task button. The deleted task will also be removed permanently from the Task 

Manager. This action will also delete the tasks created in Windows Task Scheduler and all 

sub-folders & files in the respective task folder. 
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3.7 Task Properties 

Click Task Properties to view the properties of a task. The task properties includes the 

information about the task, selected reports, site and list URLs (if applicable), report 

criteria (if any), export, publish and print settings. 

Use  and  buttons to view the properties for tasks in the Power Reports Task 

Manager window. 
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3.8 Task History 

Click Task History to view the history information for the selected task or all tasks. The 

top grid in the window shows the task name along with its start time and end time. 

 

1) Select the task from Show history for dropdown to view the history for the 

selected task. You can also use the All option in the dropdown to view history 

information for all tasks.   

2) Click on View Log hyperlink to view the errors that may have occurred when 

running the task.  

3) Click Delete in Action column to delete the task information. This will 

permanently delete the task information from the task history and all related sub-

folders and files in the respective task folder. .  

4) In the bottom grid, Click 'Export File' hyperlink to launch the exported file in its 

native application.  

5) In the bottom grid, Click 'Published to' hyperlink to open the SharePoint 

library/folder and launch the published report. 

3.9 Run Now 

Select a task and click 'Run Now' to run the task immediately. 
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3.10  Cleanup History 

Task History Cleanup 

ARKSP maintains task history including log files and temporary data for each run of the 

Power Reports task. You can cleanup task history periodically using this tool.  

Click Cleanup History in the Power Reports Task Manager toolbar. 

The Cleanup History dialog appears as shown below: 

 

1) Select 'Retain task history for last runs only' option to remove all history entries 

for each task that are older than runs (task instances).  

2) Select 'Retain task history for last days only' option to remove all history entries 

for each task that are older than the specified days. 
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4 Custom Reports  

4.1 Custom Reports Manager    

Custom Reports feature in ARKSP allows the user to select a set of reports (based on 

Report Category) and their related report fields and save them as a custom report 

template for re-use. The Custom Reports Manager allows the user to create, edit, view, 

copy and delete the custom reports. 

NOTE: The custom report templates can be created based on a single Report Category 

only. 

Click or or CTRL + S 

Custom Reports Manager screen will be displayed as shown below: 
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Crate a Custom Report 

Click create button in the Custom Report Manager to create a new Custom Report. 

 

1) Select the Report Category. The custom report template can be created based 

on a single Report Category only.  

2) Enter a unique Name and Description (optional) for the report to be created.  

3) Select the Reports and the report Fields to be included in the custom report 

template.  

4) Click Save to save the custom report template. 

The newly created custom report will be displayed in the Custom Reports Manager as 

shown below: 



CHAPTER-4–Custom Reports 

 

72 

 

Edit a Custom Report 

This feature allows you to edit an existing Custom Report. 

1) Select the Custom report you want to edit.  

2) Click Edit button.  

3) Custom Report Builder window will be displayed as shown below: 
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4) Edit the reports and the related fields, if necessary.  

5) You cannot change the report name, but can change the description of the report.  

6) Click Save to save the report settings. 

Copy a Custom Report 

This feature allows you to make a copy of an existing custom report and save it under a 

different name. 

1) Select the Custom Report you want to copy.  

2) Click 'Copy' button.  

3) Copy Report windows will be displayed as shown below: 

 

4) Enter the name and description (optional) of the new report to be created.  

5) Click OK 

Delete a Custom Report 

1) Select the Custom Report you want to delete.  

2) Click „Delete‟ button. 
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4.2 Create a Custom Report 

Click create button in the Custom Report Manager to create a new Custom Report. 

 

1) Select the Report Category. The custom report template can be created based on 

a single Report Category only.  

2) Enter a unique Name and Description (optional) for the report to be created.  

3) Select the Reports and the report Fields to be included in the custom report 

template.  

4) Click Save to save the custom report template. 
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The newly created custom report will be displayed in the Custom Reports Manager as 

shown below: 
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4.3 Filter Data 

Click  button in the toolbar to select the desired fields to view in the report. The 

list of column and row names will be displayed as below: 

 

Select the required columns and rows from the list and Click the OK button to view the 

selected fields. 

 

4.4 Refresh Data 

ARKSP stores the data in the local application database, once it gathers the data from 

SharePoint for the first time. ARKSP displays data from the local data store until the data 

is refreshed.   

To “Refresh” data, click  the button in the toolbar to refresh the data. 
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4.5 Preview & Print Report 

Click  the button in the toolbar to preview and print reports. The tabular data (as 

in grid) will be displayed as shown below: 

 

1) Click Setup button to setup your printer options.  

2) Click Print button to print the report.  

3) Click Navigation buttons in top-right to navigate through the report pages.  

4) Click Close button to close this preview window. 
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4.6 Export Report 

Click  button in the toolbar to export report data. Export Options dialog will be 

displayed as shown below: 

 

1) Select or enter the export path where the report should be stored.  

2) Enter a file name for the report to be stored.  

3) Select file type in which the data should be stored. If the file type is 'MDB', you 

can specify the table name.  

4) Click OK button to save the report in the specified path. 
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4.7 Publish Report 

Click  button in the toolbar to publish the report to a SharePoint Library. Publish 

dialog will be displayed as shown below: 

 

1) Enter a publish file name for the report to be published.  

2) Select a SharePoint library or folder where the report should be published.  

3) Select a publish type in which report should be published. If the publish type is 

'MDB', you can specify the table name.  

4) Select a file existence check option as required.  

5) Click Publish button to publish the report to a SharePoint library or folder. 

 

 

 

 

 

 

 



 

 

80 

Chapter 

5 
 

5 References 

5.1 Alert Messages 

1)  

a) Check the URL format (e.g., http://server name:port number/sitename)  

b) Check the server instance.  

c) Spell check the URL 

2)  

The entered URL may not be a valid. Enter URL in the format http://server 

name:port number/site name. 

3)  

The entered URL may not be a valid. Site URL or list name may be incorrect. 

Enter URL in the format http://server name: port number/ site name/list name. 

The currently logged on user does not have sufficient rights to the virtual server. 

Grant the required rights to the virtual server for the currently logged on user ad 

try again. 
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4)  

The currently logged on user does not have sufficient rights to the virtual server. 

Grant the required rights to the virtual server for the currently logged on user ad 

try again. 

5)  

The currently logged on user does not have sufficient rights to the list. Grant the 

required rights to the list for the currently logged on user ad try again. 

6)  

ARKSP shows the above alert when it encounters any errors while generating a 

report. Click View button to view the errors and the possible resolution. Check 'Do 

not show this message again' checkbox to turn-off the alert. You can turn-on the 

alert messages again from the Tools menu. You may also view the errors in a 

report by clicking on the 'Error' button in the bottom status bar of ARKSP 

application. 

7)  
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The specified report may be included for scheduled report generation. Please 

remove this report from scheduled task to delete. 

8)  

Password specified for the corresponding user name while creating the task may 

be invalid. 

9)  

The task may have been deleted or may not available in the Windows Scheduled 

Tasks. 

10) {Access Denied} message in the grid view for certain properties, means that 

the currently logged on user does have sufficient permissions to retrieve this 

information. Grant full rights to the virtual server for the currently logged on user 

and try running the report again. 
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5.2 Troubleshooting 

Troubleshoot a problem 

While using ARKSP, if and when a problem arises, please forward the following 

information to support@vyapin.com to revert back to you with a solution. 

1) Version of ARKSP you are evaluating or you have registered with us (version 

information could be found in "About" screen and in "Help") 

2) Additional services or resource consuming processes/applications (like anti-virus, 

indexing) running in the background on the computer where ARKSP is installed. 

3) Hardware configuration of ARKSP installed computer. 

4) 'Service Pack' version of Microsoft Office SharePoint Portal Server / Windows 

SharePoint Services / Windows OS running currently. 

5) Send us the "Error Log" (ARKSPErrorLog.txt) available in the "Log" folder of 

the installation path of ARKSP (e.g., C:\Program Files\ARKSP)  

6)  For Power Reports, send us the following "Error Log" files: 

 PRErrorLog.txt available in the "Power Reports" folder of the installation 

path of ARKSP. 

 PRTErrorLog.txt available in the "Power Reports\<<Task 

Name>>\<<Date and Time Stamp>>"  folder of the installation path of 

ARKSP 

 

5.3 Technical Support 

Technical support is available through e-mail. Send your questions to 

support@vyapin.com. 

We make every effort to respond to your request on the same day you send in your e-

mail. Please allow up to 24 hours for our technical support team to revert back to you. 
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